Permission is granted to copy any or all portions of this manual, provided that such copies are for use with the DPA product and that “© 2010-2017 Dearborn Group, Inc.”, (herein referred to as “Dearborn Group”, “DG Technologies”, or “DG”), remains on all copies.

The accompanying software, provided for use with the DPA 5, is also copyrighted. Permission is granted to copy this software for back-up purposes only.

**IMPORTANT**

To ensure your success with this product, it is essential that you read this document carefully before using the hardware. Damage caused by misuse of the hardware is not covered under product warranty.

When using this manual, please remember the following:

- This manual may be changed, in whole or in part, without notice.
- DG assumes no responsibility for any damage resulting from the use of this hardware and software.
- Specifications presented herein are provided for illustration purposes only and may not accurately represent the latest revisions of hardware, software or cabling.
- No license is granted, by implication or otherwise, for any patents or other rights of DG or of any third party.

**DPA®** and the **DG®** logo are registered trademarks of Dearborn Group, Inc. Other products that may be referenced in this manual are trademarks of their respective manufacturers.

**The DPA Product line and the products supporting the DPA have been awarded the following U.S. Patents:**

<table>
<thead>
<tr>
<th>Patent #</th>
<th>Date</th>
<th>Patent Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>6,772,248</td>
<td>08-03-04</td>
<td>Protocol adapter for in-vehicle networks.</td>
</tr>
<tr>
<td>7,152,133</td>
<td>12-19-06</td>
<td>Expanded functionality protocol adapter for in-vehicle networks.</td>
</tr>
<tr>
<td>7,337,245</td>
<td>02-26-08</td>
<td>Passing diagnostic messages between a vehicle network and a computer.</td>
</tr>
<tr>
<td>7,725,630</td>
<td>05-25-10</td>
<td>Passing diagnostic messages between a vehicle network and a computer using J1939 or J1708.</td>
</tr>
<tr>
<td>8,032,668</td>
<td>10-04-11</td>
<td>Passing diagnostic messages between a vehicle network and a computer using J1939 or J1708.</td>
</tr>
<tr>
<td>8,152,557</td>
<td>04-10-12</td>
<td>Positive locking mechanism for USB connected devices.</td>
</tr>
<tr>
<td>7,984,225</td>
<td>07-19-11</td>
<td>ASCII gateway to in-vehicle networks.</td>
</tr>
<tr>
<td>7,660,934</td>
<td>02-0910</td>
<td>ASCII gateway to in-vehicle networks.</td>
</tr>
</tbody>
</table>

It is essential that the user read this document carefully before using the hardware.

The DPA devices are to be used by those trained in the troubleshooting and diagnostics of light-duty through heavy-duty vehicles. The user is assumed to have a good understanding of the electronic systems contained on the vehicles and the potential hazards related to working in a shop-floor environment.

DG understands that there are numerous safety hazards that cannot be foreseen, so we recommend that the user read and follow all safety messages in this manual, on all of your shop equipment, from your vehicle manuals, as well as internal shop documents and operating procedures.

**Safety First**

- Always block drive, steer, and trailer wheels both front and back when testing.
- Use extreme caution when working around electricity. When diagnosing any vehicle, there is the risk of electric shock both from battery-level voltage, vehicle voltages, and from building voltage.
- Do not smoke or allow sparks or open flames near any part of the vehicle fueling system or vehicle batteries.
- Always work in an adequately ventilated area, and route vehicle exhaust outdoors.
- Do not use this product in an environment where fuel, fuel vapor, exhaust fumes, or other potentially hazardous liquids, solids, or gas/vapors could collect and/or possibly ignite, such as in an unventilated area or other confined space, including below-ground areas.
# Table of Contents

## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. INTRODUCING THE DPA</td>
<td>5</td>
</tr>
<tr>
<td>1.1. RP1210 OEM AND COMPONENT SOFTWARE COMPATIBILITY</td>
<td>6</td>
</tr>
<tr>
<td>1.2. J2534 OEM AND COMPONENT SOFTWARE COMPATIBILITY</td>
<td>6</td>
</tr>
<tr>
<td>1.3. STANDARDS AND PROTOCOLS SUPPORTED</td>
<td>7</td>
</tr>
<tr>
<td>1.4. SYSTEM REQUIREMENTS</td>
<td>7</td>
</tr>
<tr>
<td>2. GETTING STARTED WITH THE DPA</td>
<td>8</td>
</tr>
<tr>
<td>2.1. DRIVER INSTALLATION</td>
<td>8</td>
</tr>
<tr>
<td>2.2. WINDOWS SECURITY SCREEN</td>
<td>8</td>
</tr>
<tr>
<td>2.3. CONNECT USB CABLE TO THE DPA AND THEN TO PC</td>
<td>9</td>
</tr>
<tr>
<td>2.4. CONNECT VEHICLE CABLE TO THE DPA</td>
<td>9</td>
</tr>
<tr>
<td>2.5. CONNECT VEHICLE CABLE TO THE VEHICLE</td>
<td>9</td>
</tr>
<tr>
<td>2.6. FINALIZE PC INSTALL</td>
<td>9</td>
</tr>
<tr>
<td>3. SETTING UP YOUR HEAVY-DUTY OEM DIAGNOSTIC APPLICATIONS</td>
<td>10</td>
</tr>
<tr>
<td>3.1. NOTES ON SELECTING AN RP1210 COMPLIANT ADAPTER</td>
<td>10</td>
</tr>
<tr>
<td>3.2. ALLISON DOC</td>
<td>10</td>
</tr>
<tr>
<td>3.3. BENDIX ABS DIAGNOSTICS</td>
<td>11</td>
</tr>
<tr>
<td>3.4. CATERPILLAR ELECTRONIC TECHNICIAN (CAT ET)</td>
<td>11</td>
</tr>
<tr>
<td>3.5. CUMMINS INSITE</td>
<td>11</td>
</tr>
<tr>
<td>3.6. CUMMINS PowerSpec</td>
<td>12</td>
</tr>
<tr>
<td>3.7. DETROIT DIESEL DIAGNOSTIC LINK</td>
<td>12</td>
</tr>
<tr>
<td>3.8. DETROIT DIESEL DIAGNOSTIC LINK</td>
<td>12</td>
</tr>
<tr>
<td>3.9. DANA DIAGNOSTIC TOOL</td>
<td>12</td>
</tr>
<tr>
<td>3.10. EATON ServiceRANGER</td>
<td>13</td>
</tr>
<tr>
<td>3.11. EATON ServiceRANGER</td>
<td>13</td>
</tr>
<tr>
<td>3.12. FREIGHTLINER ServiceLink (INCLUDING CASCADIA MODEL – DUAL CAN CHANNELS)</td>
<td>13</td>
</tr>
<tr>
<td>3.13. MERITOR-WABCO TOOLBOX</td>
<td>13</td>
</tr>
<tr>
<td>3.15. VOLVO/MACK PREMIUM TECH TOOL (PTT) – VERSION 1.X</td>
<td>14</td>
</tr>
<tr>
<td>3.16. VOLVO/MACK VCADS</td>
<td>14</td>
</tr>
<tr>
<td>3.17. INTERNATIONAL TRUCK AND ENGINE</td>
<td>15</td>
</tr>
<tr>
<td>4. SETTING UP YOUR J2534 VEHICLE OEM APPLICATIONS</td>
<td>16</td>
</tr>
<tr>
<td>5. RUNNING THE DPA 5 BLUETOOTH CONFIGURATION UTILITY</td>
<td>17</td>
</tr>
<tr>
<td>5.1. CREATING A NEW RP1210 DEVICEID FROM A NEWLY PAIRED DPA 5</td>
<td>18</td>
</tr>
<tr>
<td>5.2. DELETING AN RP1210 DEVICEID</td>
<td>18</td>
</tr>
<tr>
<td>6. PRODUCT SPECIFICATIONS</td>
<td>19</td>
</tr>
<tr>
<td>6.1. DPA 5 PHYSICAL AND ELECTRICAL</td>
<td>19</td>
</tr>
<tr>
<td>7. TROUBLESHOOTING GUIDE</td>
<td>20</td>
</tr>
<tr>
<td>7.1. DG UPDATE – PROGRAM OVERVIEW</td>
<td>20</td>
</tr>
<tr>
<td>7.2. AUTOMATIC FIRMWARE UPDATE</td>
<td>23</td>
</tr>
<tr>
<td>7.3. TROUBLESHOOTING DPA WITH ADAPTER VALIDATION TOOL (AVT)</td>
<td>25</td>
</tr>
<tr>
<td>7.4. ADAPTER VALIDATION TOOL STARTUP</td>
<td>25</td>
</tr>
<tr>
<td>7.5. SELECTING A VEHICLE PROTOCOL FOR TESTING WITH AVT</td>
<td>26</td>
</tr>
<tr>
<td>7.6. AVT (MD/HD)</td>
<td>27</td>
</tr>
<tr>
<td>7.7. AVT (OBDII)</td>
<td>32</td>
</tr>
</tbody>
</table>
8. TECHNICAL SUPPORT AND RETURN MERCHANDISE AUTHORIZATION (RMA) .......................... 35
   8.1. TECHNICAL SUPPORT ........................................... 35
   8.2. RETURN MERCHANDISE AUTHORIZATION (RMA) ...... 35
9. WARRANTY INFORMATION AND LIMITATION STATEMENTS ........................................... 36
   9.1. WARRANTY INFORMATION ........................................ 36
   9.2. LIMITATION STATEMENTS ....................................... 36

APPENDIX A – VOLVO/MACK 2013 (AND NEWER VEHICLES) AND THE DPA 5 ................................. 37
   DG-DPA5-9OBDII-CABLE – FOR VOLVO PTT AND OTHER OBDII APPLICATIONS ........ 38
   DG-V13-XOVER-CABLE – FOR COMPONENT APPLICATIONS (I.E. ALLISON, EATON) ...... 38
   USING AVT TO TEST THIS VEHICLE PLATFORM – J1708 PROTOCOL ....................... 39
   USING AVT TO TEST THIS VEHICLE PLATFORM – ISO15765 ................................. 39
   USING AVT TO TEST THIS VEHICLE PLATFORM – J1939 ...................................... 39

APPENDIX B – SAMPLE SOURCE CODE FOR SOFTWARE ENGINEERS ........................................ 40
   RP1210 SAMPLE SOURCE CODE ................................................................................. 40
   J2534 SAMPLE SOURCE CODE .................................................................................. 40

APPENDIX C – FCC AND CERTIFICATION INDUSTRY CANADA INFORMATION ......................... 41
   INDUSTRY CANADA ................................................................................................. 41

APPENDIX D – LIST OF ACRONYMS USED IN THIS DOCUMENT ............................................ 42
1. Introducing the DPA 5

The DPA 5 products are used to connect vehicle networks to personal computers (PCs). This allows programs written for the PC to retrieve pertinent information such as fault codes, component information, as well as perform component level diagnostics, tests, and component reprogramming. The DPA 5 communicates with the PC using either a USB cable or via Bluetooth (Class I or Class II), and comes standard with the latest Technology and Maintenance Council (TMC) Recommended Practice (RP) RP1210-compliant drivers, as well as Society of Automotive Engineers (SAE) J2534-compliant drivers.

Standard DPA 5 Kit for Heavy Duty Diagnostics & Reprogramming

If you ordered the DPA 5 as part of a kit, it should include the following items:

- DPA 5 Diagnostic Tool
- 6-pin/9-pin Deutsch Connector “Y” Cable, for vehicle-side connection
- USB Cable with screw-in ears to secure the cable to the DPA 5 case
- DPA 5 Installation Disc
- Printed Quick Start Sheet
- Carrying Case

Please note that DG Technologies does customize our kits, so what you receive may vary.
1.1. **RP1210 OEM and Component Software Compatibility**

The adapter you have purchased is provided with the latest Technology and Maintenance Council (TMC) RP1210 compliant interface and has been tested with the following OEM and component applications:

- Allison DOC™
- Bendix® ACOM
- Caterpillar® Electronic Technician
- Cummins® Insite™
- Cummins PowerSpec
- Dana Diagnostic Tool™
- Detroit Diesel Diagnostic Link™
- Detroit Diesel Reprogramming Station™
- Eaton ServiceRanger
- Freightliner ServiceLink
- International® Diamond Logic Builder
- International® InTune
- International® Master Diagnostics
- International® ServiceMaxx
- International® NETS
- International® Auto Upgrade (AU)
- Mack and Volvo VCADS/PTT
- Meritor-WABCO Toolbox
- Vansco VMMS
- ZF-Meritor TransSoft

Any application claiming RP1210 compliance should work if the application and adapter both support the same protocol(s) and operating system(s).

1.2. **J2534 OEM and Component Software Compatibility**

The adapter you have purchased is provided with an SAE J2534-compliant interface (an SAE standard for electronic module reprogramming – sometimes called the “Pass Thru Programming” standard). The DPA 5 should be able to reprogram all CAN/ISO15765 vehicles, GM vehicles using the J1850 Variable Pulse Width (VPW) protocol, or other vehicles using the ISO9141 or ISO14230 protocols.

The DPA 5 has been tested with the following OEM and component applications:

- General Motors TIS2Web
- Chrysler J2534 Application
- Toyota TIS (Technical Information System)
- Honda Service Express
- Mazda Module Programming (MMP)
- Kia J2534 KMA
- Hyundai 2534 HMA
- Volkswagen Erwin
- Audi Erwin
- Nissan J2534 ECU Reprogramming Software (NERS)

All J2534 reprogramming and diagnostic software packages that are J2534-1 and J2534-2 compliant and use a protocol supported by the DPA 5 should work as long as the operating system is supported by the application. Note that not all OEMs have released J2534-2 compliant software.
1.3. Standards and Protocols Supported

The adapter you have purchased provides more protocol and standards support than any other commercially available diagnostic adapter.

1.3.1. RP1210 Defined Protocols Supported

- TMC RP1210C, TMC RP1210B, TMC RP1210A
- J1939
  - J1939@250k – Standard J1939
  - J1939@500k – Per J1939/14
- CAN (ISO11898)
- CAN@500k/J2284/GMLAN/IESCAN
- J1708/J1587
- J1850 GM (Class 2) – J1850VPW
- ISO9141-2
- ISO14230 (KWP2000)

1.3.2. J2534 Defined Protocols Supported

- SAE J2534-1
- SAE J2534-2
- CAN (Raw CAN)
- J1850VPW (GM Class II)
- ISO15765
- GMLAN (HSCAN, SWCAN)
- ISO14230 (KWP2000)
- ISO9141-2

1.3.3. Additional Protocols Supported by Native Drivers

- J2411 (GM SWCAN)
- ALDL

1.4. System Requirements

We recommend a computer compatible with the latest version of the TMC RP1208 (PC Selection Guidelines for Service Tool Applications).

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>IBM-Compatible</td>
</tr>
<tr>
<td>Processor</td>
<td>1GHz or Faster</td>
</tr>
<tr>
<td>RAM</td>
<td>256MB (512MB Preferred)</td>
</tr>
<tr>
<td>USB Port</td>
<td>USB Version 1.1 or Higher</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows Vista (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 8 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 10 (32-bit or 64-bit)</td>
</tr>
</tbody>
</table>
2. Getting Started with the DPA

2.1. Driver Installation

Attention!

- Install DPA drivers from CD or website before connecting DPA to your PC.
- To install drivers you must be logged into the administrator account or have administrator privileges on your PC.
- If you run into problems installing the drivers or the DPA, please review the FAQ pages at www.dgtech.com

The DPA drivers provided on the installation CD are installed by inserting the disc into your PC’s CD-ROM drive. The latest drivers and firmware are always available at www.dgtech.com/downloads. If you have any questions about the install, please contact our technical support staff or review the FAQ pages at www.dgtech.com/faqs.

If setup does not begin automatically, use the following sequence:

1. Press the **Windows** and **E** key at the same time. This will launch the File Explorer application.
2. Browse to the CD or DVD drive that you inserted the installation disk into.
3. Double click the DPA5Install.exe

After the drivers are installed, restart your computer. While rebooting, continue following the next instructions.

2.2. Windows Security Screen

If you receive this Windows Security screen, check the **Always trust software from “DG Technologies”** and press the **Install** button. Otherwise, the driver installation will fail.
2.3. Connect USB Cable to the DPA and Then to PC

Connect the USB cable to the DPA and PC. The USB cable that comes with the DPA 5 has ears that allow the cable to be screwed into standoff screws on the DPA 5 frame, greatly reducing the chance of breaking the USB connector on the DPA circuit board.

PC-side USB Cable

2.4. Connect Vehicle Cable to the DPA

Connect the vehicle-side cable to your DPA.

Do not connect to vehicle first! Potential to blow a fuse on the vehicle!

WARNING

2.5. Connect Vehicle Cable to the Vehicle

Now, connect the DPA to the vehicle, verifying that the DPA Power LED is lit.

Vehicle-Side Cable (Heavy-Duty)

2.6. Finalize PC Install

Plug the DPA 5 into the PC via the USB cable with the DPA 5 powered on. The following screen A will display in the lower right corner for about five seconds, followed by screen B. Your DPA 5 is now ready for use.
3. **Setting Up Your Heavy-Duty OEM Diagnostic Applications**

The DPA works with all RP1210C, RP1210B, and RP1210A compliant applications that support J1708/J1587, CAN/J1939, J1850 VPW (GM Class II) and the ISO15765 protocols along with many others. This section shows how to configure the most common RP1210-compliant diagnostic applications to work with the DPA 5.

### 3.1. Notes on Selecting a RP1210 Compliant Adapter

Selecting an RP1210 adapter, commonly referred to as a Vehicle Datalink Adapter (VDA) varies widely from application to application; however, the terminology remains similar. The following table helps to introduce you to the terminology and helps you to make the correct selections the first time.

- You must set up every application (in their own individual way) to use the DPA!
- Not all OEM applications save the adapter configuration! Some make the user select the adapter to be used every time the application is opened.

<table>
<thead>
<tr>
<th>If You See These Terms</th>
<th>Select This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Dearborn Group DPA 5 Multi Application Or DGDPA5MA</td>
</tr>
<tr>
<td>API</td>
<td></td>
</tr>
<tr>
<td>DLL</td>
<td></td>
</tr>
<tr>
<td>Manufacturer</td>
<td></td>
</tr>
<tr>
<td>Adapter Manufacturer</td>
<td></td>
</tr>
<tr>
<td>Device Name</td>
<td>This is the name of the tool you want to use to communicate with. For the DPA 5 driver set these will be the most common entries that you will see. Make sure that if you are trying to connect to a Bluetooth tool you have configured it using the DPA 5 Bluetooth Configuration utility first.</td>
</tr>
<tr>
<td>Adapter Name</td>
<td>- DG DPA 5 Dual-CAN (MA) USB, USB</td>
</tr>
<tr>
<td></td>
<td>- DG DPA 5 Pro (MA) USB,USB</td>
</tr>
<tr>
<td></td>
<td>- DPA 5 Dual-CAN #[Bluetooth ID] (MA) Bluetooth, Wireless</td>
</tr>
<tr>
<td></td>
<td>- DPA 5 Pro #[Bluetooth ID] (MA) Bluetooth, Wireless</td>
</tr>
<tr>
<td>Device Number</td>
<td>This corresponds to the DeviceInformation# in the DGDPA5MA.ini file which is located in the default Windows directory. In nearly all cases the user is presented with a number followed by a description of the device. Rely on the DeviceName/Adapter Name description to determine the DeviceID.</td>
</tr>
<tr>
<td>DeviceID</td>
<td></td>
</tr>
<tr>
<td>Protocol (Depends on Application)</td>
<td>Most Commonly Encountered:</td>
</tr>
<tr>
<td></td>
<td>✓ J1708 (J1708/J1587)</td>
</tr>
<tr>
<td></td>
<td>✓ J1939</td>
</tr>
<tr>
<td></td>
<td>✓ ISO15765</td>
</tr>
<tr>
<td></td>
<td>✓ CAN</td>
</tr>
</tbody>
</table>

### 3.2. Allison DOC

1. Start program.
2. Click **Connect to Vehicle**.
3. Select the Correct Transmission Type.
4. Uncheck **Smart Connect**.
5. Click **Connect**.
6. Click **Advanced Setup**.
7. Select vendor of **Dearborn Group DPA 5 Multi Application**.
8. Select protocol of **J1939** or **J1708**.
9. Select the correct **DPA**.
10. Click OK.

### 3.3. Bendix ABS Diagnostics

NOTE: DO NOT RUN Bendix ABS Diagnostics until you have done the following:

1. Start program.
2. If Diagnostic Interface Selection dialog box does not appear, click on Vehicle Interface Adapter icon.
   a. Select RP1210A Device Using J1708 Line: [Correct DPA entry for the tool you are using].
3. Click OK.

### 3.4. Caterpillar Electronic Technician (CAT ET)

1. Start Program.
2. Click Utilities ➔ Preferences ➔ Communications from the menu bar.
3. Click on Communication Interface Device dropdown box.
4. Select RP1210 Compliant Device.
5. Click Advanced
6. Select the correct DPA in the RP1210 Communication Adapter Device box.
7. Click OK
8. Check Enable Dual Data Link Service
9. Click OK.

**CAT ET Notes:**
- Enable Dual Data Link. This checkbox should be “checked” in most cases. However, on some older J1708 (ATA) only vehicles, ET will not work with this checkbox checked. If ET does not connect, try "un-checking", or “checking” this button.
- The DPA product line does not support the CAT Data Link (CDL) protocol that is still common among certain CAT off-highway vehicles and industrial stationary equipment. CDL is a proprietary protocol and there are no generic adapters on the market that support this protocol.
  - To find out if your vehicle/equipment is CDL or a standard protocol (J1708/ATA, J1939), you should look at the diagnostic connector for that equipment in the service manual.

### 3.5. Cummins INSITE

1. Start Program.
2. Click on File ➔ Connections ➔ Add New Connection.
3. Click Next.
4. Click radio button for RP1210 Adapters and click Next.
5. Select correct vendor, device, and protocol:
   a. Dearborn Group DPA 5 Multi Application
   b. Select the correct DPA.
   c. Auto Detect.
      i. If you are on an older vehicle and it does not connect, choose J1708.
6. Click Next and a Connection Name screen appears.
7. Click Next and a screen prompts you to indicate whether you want to make this connection active or set up another connection.
8. Click on make this connection active.
9. Click Finish.
3.6. **Cummins PowerSpec**

- Start Program.
- Click on **Advanced**.
- Click **Settings** button.
- Datalink Adapter:
  - a. Dearborn Group DPA 5 Multi Application
- Device List:
  - a. Select the correct DPA.
- Datalink Protocol:
  - a. Auto Detect (or choose protocol for your engine).
- Click **Save** button.

**PowerSpec Notes:**

PowerSpec Version 5.5 or newer is required to use the DPA 5. Older versions of PowerSpec were not completely RP1210-compliant.

3.7. **Detroit Diesel Diagnostic Link**

3.7.1. From Windows Start Menu

1. Start ➔ Programs ➔ Detroit Diesel ➔ Diagnostic Link ➔ SID configure
2. Select the correct DPA.
3. Click **OK**.

3.7.2. From Inside DDDL

1. Tools ➔ Options ➔ Connections Tab ➔ SID Configure.
2. Select the correct DPA.
3. Click **OK**.

3.8. **Detroit Diesel Diagnostic Link**

A. If you have the Detroit Diesel Electronic Tool Suite on your desktop:

1. Select **Detroit Diesel Electronic Tool Suite** icon from desktop.
2. Select **Configure** button.
3. Select the correct **DPA**.
4. Select **OK** button.
5. Select **Refresh** button.
6. Click on highlighted DDDL 6 item.
7. Select Look at active and inactive faults.

B. If you have the Diagnostic Link icon on your desktop:

1. Select Diagnostic Link icon from desktop.
2. Select Look at active and inactive faults.
3. To change the adapter, select Tools | Options | Interface
4. Select the correct **DPA** from Local Communication Interface drop-down list.
5. Select **OK** button.

3.9. **Dana Diagnostic Tool**

1. Start program
2. Under Adapter Selection, choose the correct DPA.
3. Select Connect J1708 or Connect J1939 or Connect PLC as appropriate for your controller.

3.10. Eaton ServiceRanger

1. Start Program
2. Click Tools ➔ Settings ➔ Connection.
3. Under Driver choose Dearborn Group DPA 5 Multi Application
4. Select the correct DPA for both the J1708 and J1939 device.
5. Click OK.

3.11. Eaton ServiceRanger

1. Start Program
2. Click Go To ➔ Settings ➔ Select Connection Settings
3. Under Connection Mode select Vehicle
4. Under Communication Adapter choose Dearborn Group DPA 5 Multi Application
5. Select the correct DPA for both the J1708 and J1939 device.
6. Click Apply.

3.12. Freightliner ServiceLink (Including Cascadia Model – Dual CAN Channels)

1. Start program.
2. From the top menu bar, choose Admin.
3. Click on Show All Devices.
4. Vendor = Dearborn Group DPA 5 Multi Application
5. J1708 Device = Select the correct DPA
6. J1939 Device = Select the correct DPA
7. CAN Device
   a. Click Configure
   b. Select the correct DPA
8. Click Save Settings.

3.13. Meritor-WABCO Toolbox

1. Start Program.
2. Click System Setup; then select COM Port.
3. Select Dearborn Group DPA 5 Multi Application; the protocol to use is J1939 or J1708.
4. Select the correct DPA and click OK.


1. Start Program.
2. Select Settings from the PTT menu.
3. Go to the Communication Unit tab:
4. Highlight the correct DPA.
5. Select Activate (green circle with checkmark).
6. In a few seconds, under the Status column, Activated will appear next to DPA that you selected.
7. Select the OK Button.
   o Wait a few minutes to establish connection. If connection doesn't occur, re-boot the PC.
   o Do not select Connect immediately after PTT opens. Reading product data.... will appear after a little bit of time while the connection is being established.
3.15. **Volvo/Mack Premium Tech Tool (PTT) – Version 1.X**

1. Start Program.
2. Select **Settings** from the PTT menu.
3. Go to the Communication Unit configuration tab:
   a. It is here that you select the settings for each adapter that you may use. For example, if you have an RP1210A adapter, it is here that you select which adapter, port, and protocol.
   b. NOTE: This identifies the settings for each adapter. It does not select which adapter the PTT application will use to communicate with the vehicle.
4. Go to the Comm unit selection tab:
   a. It is here that you identify which adapter is to be used by the PTT application to communicate with the vehicle. You may have to change this selection depending upon the vehicle.
   b. For example, if you typically use an 88890020 adapter in direct mode, when you need to communicate with an older vehicle you will need to change to RP1210A adapter or the 9998555 adapters, depending upon the vehicle.

3.16. **Volvo/Mack VCADS**

3.16.1. From Initial VCADS Setup

1. When prompted to configure a Communication Unit select **RP1210A adapter**.
2. When prompted for the adapter, select the correct **DPA**.
3. Select the correct entry for the Port (USB or Bluetooth)
4. Select **J1708** for the protocol.
5. When prompted for the Electrical Systems.
   a. Click **Volvo Trucks – VERSION2** and select **RP1210A Adapter**
   b. Click **Volvo Trucks – Vehicle electronics ’98** and select **RP1210A Adapter**
   c. Click **Mack Trucks – V-MAC I/II/III, ITC** and select **RP1210A Adapter**
   d. Click **Volvo Trucks – V-MAC IV** and select **RP1210A Adapter**
6. Continue with installation.

3.16.2. From Inside VCADS

1. Start Program.
2. Click the **Tools** menu and choose **Options**.
3. Select the **Comm. Unit Configuration** tab.
4. Select **RP1210A Adapter** and then select the correct **DPA**.
5. Select the correct entry for the Port (USB or Bluetooth).
6. Select **J1708** for the protocol.
7. Go to the **Comm. Unit Selection** tab.
   a. Click **Volvo Trucks – VERSION2** and select **RP1210A Adapter**
   b. Click **Volvo Trucks – Vehicle electronics ’98** and select **RP1210A Adapter**
   c. Click **Mack Trucks – V-MAC I/II/III, ITC** and select **RP1210A Adapter**
   d. Click **Volvo Trucks – V-MAC IV** and select **RP1210A Adapter**
7. Click **OK**
3.17. International Truck and Engine

3.17.1. Master Diagnostics (MD Fleet)
1. Start program.
2. Choose File ➔ MD Settings ➔ COM Device ➔ Window with general VDA selection
3. Select Dearborn Group DPA 5 Multi Application ➔ Window with specific port, select the correct DPA.

3.17.2. Navistar Hydraulic ABS
1. Start program.
2. Choose File ➔ Hydraulic ABS Settings ➔ COM Device ➔ Window with general VDA selection
3. Select Dearborn Group DPA 5 Multi Application ➔ Window with specific port, select the correct DPA.

3.17.3. Navistar IPC
1. Start program.
2. Choose File ➔ Settings ➔ COM Device ➔ Window with general VDA selection
3. Select Dearborn Group DPA 5 Multi Application ➔ Window with specific port, select the correct DPA.

3.17.4. Diamond Logic Builder (DLB)
1. Start program.
2. Choose Tools ➔ Select Com Link ➔ Listing of adapters
3. Select Dearborn Group DPA 5 Multi Application ➔ Listing of ports, select the correct DPA.

3.17.5. Service Assistant (The new MD Fleet)
1. Start program.
2. Press third button from the top along the left side (has an icon that looks like a miniature interface cable.)
   a. A window comes up that says Communication Device Selection and has two drop down boxes.
   b. Select Dearborn Group DPA 5 Multi Application ➔ , select the correct DPA.

3.17.6. ServiceMaxx:
1. Select ServiceMaxx icon from desktop
2. Enter username and password (if required)
3. Select Tools ➔ Select COM Link ➔ Dearborn Group DPA 5 Multi Application ➔ , select the correct DPA ➔ select J1708 or J1939 depending on engine type.
4. “Searching for Engine” appears
5. Select engine type when prompted and click OK button.
4. Setting Up Your J2534 Vehicle OEM Applications

Setting up and reflashing of a component using a J2534-compliant OEM is out of the scope of this manual. For more information, you can refer to the OEM application documentation or you can download the OEM application reflashing guide from the DG Technologies downloads page under VSI-2534 device.

In general, there will be a screen that will appear at some point that allows a user to select a J2534-compliant Vendor and Device for the reflashing event. When you see this type of screen, choose Dearborn Group, Inc. and/or the DPA 5.

The General Motors TIS2Web - J2534 Application VDA selection screen.
5. Running the DPA 5 Bluetooth Configuration Utility

Before switching communications modes from USB to Bluetooth and vice-versa, the DPA 5 must be powered off and then back on.

DG recommends first reading and following the instructions in the DPA 5 Series Bluetooth Configuration Manual available from:

- Start ➔ All apps ➔ DGTech DPA 5 ➔ Bluetooth Configuration Manual

That document includes the following section. This document includes how to create the DeviceID to use the DPA 5 in Bluetooth mode with your diagnostic application.

After you have successfully paired your DPA 5 with the Bluetooth and have created the Virtual COM Port, run the Bluetooth Configuration Utility to create an RP1210 DeviceID entry that can be seen by OEM software applications:

- Start ➔ All apps ➔ DGTech DPA 5 ➔ DPA 5 Bluetooth Configuration Utility

You must go through this configuration utility to create RP1210 DeviceID entries. If you do not, the DPA 5 in Bluetooth mode will not work with your OEM applications!
What the DG Bluetooth Configuration Utility does:

- Display existing DPA 5 Bluetooth RP1210 DeviceID pairings.
- Allows you to delete an RP1210 DeviceID pairing.
- Discover DPA 5 Bluetooth devices on Virtual COM Ports.
- Create a new RP1210 DeviceID pairing that can be used by OEM software applications.

Note: The DPA 5 must have power in order to create the Virtual COM Port and RP1210 DeviceID pairing.

5.1. Creating a New RP1210 DeviceID from a Newly Paired DPA 5

After you have paired a DPA 5 with your PC and created a Virtual COM Port click the Discover Bluetooth DPAs button. Any Bluetooth DPAs that you have paired with will be automatically added to the DGDP5MA.INI file. OEM applications will now be able to see and use that particular DPA 5 as RP1210 DeviceID=160.

NOTE: Sometimes the detection process through the virtual COM port does not see the DPA on the first attempt. If this is the case, try the discovery process again.

5.2. Deleting an RP1210 DeviceID

If you want to delete an RP1210 DeviceID, simply select that entry and click Delete Pairing. Note that after the RP1210 DeviceID has been deleted, it will NOT appear in OEM software applications for selection. For information on Bluetooth (including FCC and IC identification), see the Bluetooth Configuration Manual. It can be found in the Windows Start Menu.
6. **Product Specifications**

6.1. **DPA 5 Physical and Electrical**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>6.1 x 2.5 x 1.2 inches</td>
</tr>
<tr>
<td>Voltage Requirements</td>
<td>9 – 32 Volts DC</td>
</tr>
<tr>
<td>Current Requirements</td>
<td>250mA maximum through voltage range</td>
</tr>
<tr>
<td>Operating Temperature Range</td>
<td>-40 to +85C</td>
</tr>
<tr>
<td>Wired PC Communications Type</td>
<td>USB Version 1.1 or Higher</td>
</tr>
<tr>
<td>Wired Connection</td>
<td>USB Cable (up to 15 feet)</td>
</tr>
<tr>
<td>Wireless Connection</td>
<td>Bluetooth (Most DPA 5 units are equipped with Class 1 radio)</td>
</tr>
<tr>
<td>Vehicle-Side Connector</td>
<td>DB25 Female</td>
</tr>
<tr>
<td>PC-Side Connector</td>
<td>Standard B-Type USB Jack</td>
</tr>
<tr>
<td>PC Device Drivers</td>
<td>TMC RP1210C (RP1210B, RP1210A) Compliant Drivers</td>
</tr>
<tr>
<td></td>
<td>DG Native Drivers</td>
</tr>
</tbody>
</table>
7. Troubleshooting Guide

7.1. DG Update – Program Overview

DG Update is an application that is installed with your DPA drivers. It will run (by default) once every 30 days, and will keep you up-to-date with the latest versions of drivers for all your DG Technologies products. With this application running regularly and Automatic Firmware Update (see DPA user manual) turned on, this will keep your DPAs up-to-date with drivers and firmware. DG recommends our customers keep up-to-date so that your OEM and component manufacturer diagnostic applications run smoothly.

The utility will run once every 30 days as a user logs on. This value is configurable, but defaults to 30 days. It can also be invoked manually from the Windows Start Menu:

Start ➔ All apps ➔ DGTech Utilities ➔ DG Update

7.1.1. DG Update – Internet Connection Required

The DG Driver Update utility depends on successfully connecting to the Internet (to one of DG’s servers) to retrieve the latest version information and to download the latest drivers and applications if necessary.

Many companies install firewalls and virus protection and these may block the DG server queries and responses. If you are connected to the Internet and have issues running DG Update (getting “Unable to connect to the internet to check for updates.” messages), ensure that your firewall or virus protection will allow a connection to the Internet.

7.1.2. DG Update – Initial Screen

When the utility runs as a user logs on, the following screen will appear in the lower right hand corner of the screen. If you want to check for updates, ensure that your PC is connected to the Internet and click Continue. Clicking Cancel will cause DG Update to wait until the next time it is scheduled to run. Clicking Continue will bring up the main update screen.

![Check for updates screen](image-url)
7.1.3. DG Update – Main Update Screen

The main screen appears looking like this. Depending on which products are installed on your PC, the grid will display pertinent information about them. When selecting DG Update from the Windows Start Menu, this is the first screen to appear.

Connect your PC to the Internet and click the Refresh button. Due to the nature of TCP/IP communications, errors connecting or sending/receiving of data are slow to appear, however the user will eventually be notified if there was a problem.

If the check for updates was successful, the second column of the grid will display information returned from the DG server showing the most current versions. Should an install be out of date the color of the row will be red.

7.1.4. Successful Connect – Updates Available

In this case, the DPA 5 drivers and RP2110 Utilities are out of date (red), the user will be presented with a prompt notifying them that there are updates available. Only if updates are available will the Download button and progress bar show up on the screen. The progress bar will keep you informed of the download progress should you choose to download the latest drivers by clicking the Download button.
When you click the **Download** button, you will be prompted to confirm starting of the download.

![Prompt asking if drivers should be downloaded](image)

Note: The DG Update application can only download and install one item at a time. The user will be prompted for whichever one they want to update first.

After choosing **Yes**, the program will download the drivers and update the progress bar while doing so. Once the drivers have been downloaded, the application will unzip them and start the installation process. The dialog box will go away after the install has been started.

**Do not disconnect your DPA or shut down your computer until installation is complete**

After the drivers have been downloaded (to the Windows temp directory – if you wish to save them for other machines), they will be unzipped and the program will exit right after starting the new driver installation. Follow the installation instructions in the appropriate User Manual.

### 7.1.5. Advanced Settings – Setting Default Time for Check for Updates

If you want to turn off, or alter the timeout period where the user is prompted to check for updates (the dialog below), press the **Settings** button. The advanced settings dialog box will be displayed. To turn off the checking prompt, set the value to 0 (zero). Otherwise, you can set the number of days between checks.
7.2. **Automatic Firmware Update**

Even though automatic firmware update comes defaulted to on, there may be a time you need to update your DPA firmware manually. The first step in a manual firmware update is to find which version of firmware you have. You can use the AVT utility after connecting the DPA to a power source.

Start ➔ All apps ➔ DGTech Utilities ➔ Adapter Validation Tool

Select the correct DPA adapter:

- **Vendor** DGDPA5MA – Dearborn Group DPA 5 Multi Application
- **Device** Select the correct DPA
  - 1 – DG DPA 5 Dual-CAN USB - USB
  - 2 – DG DPA Pro USB - USB
- **Protocol** J1708 (any protocol works)

Then click the Run Test button. When the test has finished running, go to the RP1210 Status Window and scroll down to the line that reads [RP1210_ReadDetailedVersion] and look for the entry “FW=”. The last numbers on the line indicates which version of firmware you have (note the yellow circle). If you are not at the correct level (see manual cover page for which version you should be at), then you need to run the DPA Firmware Updater outlined in the following steps.

In the example below FW= has two numbers. The first is the hardware version (6.01), the second the firmware version (65.305).
7.2.1. Launch the DPA Firmware Updater Program

1. Stop all applications that are using the DPA 5 (if any).

2. Start the DPA Firmware Updater program:

   Start ➔ All apps ➔ DGTech DPA 5 ➔ DPA Firmware Updater

3. Select the correct firmware file (the latest version is already selected by default). If the firmware file exists, the Firmware box will turn green.
   a. NOTE: Firmware files are located in separate sub-directories under the Utilities directory where the DPA drivers are installed, typically:
      \C:\Dearborn Group Products\DPA 5\Utilities\DPA5DC_Firmware\DPA5304.s19

4. Click on the Update Firmware button and select Yes if you receive a warning dialog.

5. After the download is finished, disconnect power from the DPA, wait 5 seconds and then reconnect power.

After you have finished installing the Windows device drivers you can begin using your DPA. If the Automatic Firmware Update option is on, every time you connect to the DPA the drivers check to see if a newer version of firmware is available. If a newer version is available the user will be prompted to upgrade to that version. Press Yes and the upgrade process begins automatically. After the firmware update, restart your application.

DO NOT DISCONNECT POWER FROM THE DPA 5 DURING A FIRMWARE UPDATE!!! ALLOW THE UPDATE TO FINISH OR YOU WILL HAVE TO MANUALLY UPDATE THE FIRMWARE!
7.3. Troubleshooting DPA with Adapter Validation Tool (AVT)

If your Software application is having trouble communicating with the DPA, you can use the Adapter Validation Tool (AVT) to troubleshoot the DPA and validate that the DPA drivers are installed properly.

- Please check that the OEM application is configured to use the DPA, and the correct protocol is selected.

After you have followed the instructions to install the DPA drivers, connect the DPA to the vehicle and ensure the Power LED is on. Then connect it to the PC and listen for the “USB device found” sound. If you do not hear this sound, the PC is not communicating with the DPA, try another USB port until you hear that sound.

- If you plug in a DPA (or any other USB device) and get the New Hardware Found wizard, do not click Cancel. Go through the wizard completely! IF YOU CLICK Cancel, THE DPA WILL NOT WORK!

7.4. Adapter Validation Tool Startup

Click AVT on the desktop or from the start menu and a screen will be displayed with two different AVT versions to choose from.

- Click on the MD/HD truck button if you have a 6 or 9-pin Deutsch connector. This is most typically found on medium and heavy-duty vehicles and J1708/J1587 and J1939 are the most common protocols.

- Click on the OBDII car button if you have an OBDII connector. This is most typically found on light and medium-duty vehicles and CAN/ISO15765, J1850, ISO9141, and ISO14230 are the most common protocols.

- You can use either program for the 2013 (or newer) Volvo chassis with Volvo engine that has the OBDII connector. See Appendix A for more information on testing this platform using the MD/HD version of AVT.
7.5. Selecting a Vehicle Protocol for Testing with AVT

J1708 Connector (6-pin Deutsch)
This connector only has the J1708/J1587 protocol.

J1939 Connector (9-pin Deutsch)
OEMs switched to this connector when they moved to J1939. J1708 may not be available.

OBDII Connector

OBDII protocols are J1850VPW (GM/Chrysler), J1850PWM (Ford), ISO9141 (Euro/Asian), KWP2000 (Euro/Asian) as well as the ISO15765 (11-bit/29-bit CANID) protocol mandated for all vehicles since 2008.

AVT (OBDII) allows the user to select "OBDII" as a protocol and AVT will cycle through all OBDII protocols to see what protocol the vehicle supports.

The DPA 5 supports all OBDII protocols except the J1850PWM protocol. This protocol was prominent on Ford vehicles prior to 2005 when Ford switched to ISO15765.
7.6. **AVT (MD/HD)**

Adapter Validation Tool for Heavy and Medium-Duty Vehicles,

Select the correct DPA:

- **Vendor** DGDPA5MA - Dearborn Group DPA 5 Multi Application
- **Device** Select the tool you want to communicate with. This could be a USB or Bluetooth tool.
- **Protocol** J1708 or J1939 (depending on your application)

Then click the **Run Test** button. Depending on the results of the test, both the **RP1210 Status Window** and **RP1210 Data Message Window** will turn **green** (pass) or **red** (fail).

### 7.6.1. AVT Test Outcomes

If the **RP1210 Status Window** turns **red**, then there is a problem causing the PC to not communicate with the DPA. Disconnect the DPA from the vehicle and PC; then reconnect them, this time connecting to another USB port on the PC.

If the **RP1210 Status Window** turns **green** and the **RP1210 Data Message Window** turns **red**, then the PC is connecting to the DPA, but not receiving messages. Check the vehicle ignition switch and vehicle to adapter cabling. Disconnect the DPA from the vehicle and PC; then reconnect them.

*If you see data in the RP1210 Data Message Window, your DPA is installed and functioning properly! Refer to the chapter on how to configure your OEM application to use the DPA.*

Read the **Test Results Discussion and Next Steps** screen carefully and follow those directions to help diagnose where the issue may be. If, after reading and following those instructions, you cannot get the DPA working, please contact DG technical support.
7.6.2.  Good Connection (PC to DPA), Good Read of Data (DPA to Vehicle) – Green/Green

The above screen snapshots show the PC successfully connecting to the DPA (RP1210 Status Window) and the successful reading of data bus data (RP1210 Data Message Window) from the J1939 data bus.

- A Green/Green result indicates the DPA is working perfectly and is seeing data on the data bus. The area to work on is configuring the OEM application to use the DPA (see Chapter 7).

7.6.3.  Good Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Green/Red

The above screen snapshots show the PC successfully connecting to the DPA (RP1210 Status Window) but AVT is not able to read data bus data (RP1210 Data Message Window) from the data bus selected (J1939).

- A Green/Red result indicates the DPA is working perfectly, but it is not seeing data on the data bus that was selected. Choose another protocol and check that the ignition switch is on.
7.6.4. **Bad Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Red/Red**

The above screen snapshots show the PC not connecting to the DPA (RP1210 Status Window).

- A Red/Red result indicates the PC is not seeing the DPA. Unplug DPA from vehicle and PC and reconnect to both using a different USB port. Ensure that you hear the da-ding “USB Device Found” sound. If you cannot hear the sound, reboot the PC and run AVT again.

7.6.5. **Not Seeing DPA in OEM Application VDA Selection List**

If you have installed the DPA drivers and can get AVT to a Green/Green outcome, you should be able to configure your diagnostic application to use the DPA. If your diagnostic application does not display the DPA you are looking for in their VDA selection dialog box, this could indicate one of three things:

1. The application is not RP1210 compliant and does not work with the DPA.
   - Some applications require a specific, proprietary adapter.

2. **Application** is RP1210 compliant, but DPA does not support the protocol needed.
   - Some VDAs create issues with the RP121032 INI file when they install/uninstall.
   - Many OEM diagnostic applications are aware of this issue and can read through the errors.

When the AVT software is launched, you will be told if a problem exists in the main RP121032 INI file. If you wish to fix this issue **(very highly recommended)**, press the **Fix/Change RP121032.INI File** button on the main screen. If your PC is running Windows Vista or Windows 7, you will be prompted for administrator privileges. The following is the dialog box that will appear when AVT is launched and a problem is found in the main RP121032 INI file.
When you press the **Fix/Change RP121032.INI File** button, AVT will bring up a separate program called **Fix INI** that will allow you to view and fix the RP121032 INI file if there are errors detected.

In the example below, a bad INI file was detected (depicted by a yellow background)

Click the **Make Changes** button and the INI file problem will be corrected.

![Image of Fix/Change INI File Utility](image)

The next picture shows the dialog box indicating that the INI file was fixed.

![Image of Fix/Change INI File Utility dialog box](image)

7.6.6. **Advanced Testing Dialog**

With the J1939 data bus moving to 500k, there is a lot of RP1210 and J1939 committee focus on VDA vendors doing J1939 automatic baud detection to detect either a 250k or 500k J1939 data bus without creating issues. There is also a growing need for advanced testing on vehicles that have a second CAN data bus.

The DPA 5 API Supports the following commonly used RP1210_ClientConnect() modifications:

- Protocol:Baud=Auto
- Protocol:Baud=XXX
- Protocol:Channel=X
- Protocol:Baud=Auto;Channel=X
- Protocol:Baud=XXX;Channel=X

Pressing the **Advanced Test** button brings up the dialog box shown below.
7.6.7. Vendor, Device, Protocol

Vendor, Device and Protocol fields are the same as described in normal testing above.

7.6.8. Baud Rate Drop Down List Box

The Baud Rate drop down list box allows the user to select one of the supported protocol speeds for the selected protocol. The entries in this list box come from the VDA vendor’s INI file. Click the Use Baud Rate checkbox to activate a “Protocol:Baud=XXX” connection. If both the Use Baud Rate and Use Channel checkboxes are checked, then AVT will initiate a “Protocol:Baud=XXX;Channel=X” connection.

7.6.9. Channel Drop Down List Box

The Channel drop down list box allows the user to select one of the supported channels for the selected device. The entries in this list box come from the VDA vendor’s INI file. Click the Use Channel checkbox to activate a “Protocol:Channel=X” connection. If both the Use Baud Rate and Use Channel checkboxes are checked, then AVT will initiate a “Protocol:Baud=XXX;Channel=X” connection.

7.6.10. Vendor Supports CAN Auto Baud Checkbox

This checkbox indicates whether or not the API supports CAN (CAN, J1939, ISO15765) automatic baud detection. Even though this variable may be set to TRUE, the next four fields indicate whether the API supports Baud=XXX connect formats for CAN, J1939, and ISO15765. This field is just an informational field, and not all VDA vendors will support this feature.

7.6.11. Protocols Supporting Baud=XXX

These checkboxes indicate whether or not the API supports setting a specific baud rate (or automatic baud detection) for a specific protocol. These entries come from the VDA vendor’s INI file. These fields are just for informational purposes. Not all VDA vendors will support this feature.

7.6.12. Advanced Testing Commands – No Error Checking

When using this dialog box to initiate an advanced test, there is no error checking done to prevent the user from initiating a “Baud=XXX” or “Channel=X” connection to a VDA even if the vendor does not support that connection format.
7.7. AVT (OBDII)

Adapter Validation Tool for Light and Medium-Duty Vehicles.

Select the correct Device:

- **Device**: DPA 5 – Dearborn Group, Inc.
- **Protocol**: OBD II
  - Using the OBD II protocol selection means that AVT will attempt to connect using all OBDII protocols that the selected adapter supports (i.e. J1850VPW, ISO9141, ISO14230, ISO15765, etc) and with all OBDII options and OBDII speeds for that protocol (i.e. CAN 1Mb 11-bit, CAN 1Mb 29-bit, CAN 500Kb 11-bit, CAN 500Kb 29-bit, etc). DG recommends using the OBDII protocol setting initially since all vehicles after 1996 have to support an OBDII protocol.
  - You can also use a specific protocol and AVT will connect using all speeds and options for that individual protocol.
  - **The DPA 5 supports all OBDII protocols except the J1850 PWM protocol. This protocol was prominent on Ford vehicles prior to 2005.**

Then click the **Run Test** button. Depending on the results of the test, both the **J2534 Status Window** and **J2534 Data Message Window** will turn **green** (pass) or **red** (fail).

7.7.1. AVT Test Outcomes

If the **J2534 Status Window** turns red, then there is a problem causing the PC not to communicate with the adapter. This may be something as simple as having power to the adapter or having a USB cabling issue. Disconnect the adapter from the vehicle and PC; then reconnect them, this time connecting to another USB port on the PC.

If the **J2534 Status Window** turns green and the **J2534 Data Message Window** turns red, then the PC is seeing the adapter, but not seeing messages from the vehicle. Check the vehicle ignition switch and vehicle to adapter cabling; disconnect the adapter from the vehicle and PC; then reconnect them.

If you see data in the **J2534 Data Message Window**, then the adapter is installed and functioning properly.
If after following the **Test Results Discussion and Next Steps** screen, you cannot get the adapter to read data, contact DG technical support.

### 7.7.2. Good Connection (PC to DPA), Good Read of Data (DPA to Vehicle) – Green/Green

The above screen snapshots show the PC successfully connecting to the DPA and the successful reading of data bus data from the CAN data bus. Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.

### 7.7.3. Good Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Green/Red

The above screen snapshots show the PC successfully connecting to the DPA but the application is not able to read data bus data from the data bus selected (CAN). Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.
7.7.4. Bad Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Red/Red

The above screen snapshots show the PC not able to connect to the DPA at all. Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.
8. Technical Support and Return Merchandise Authorization (RMA)

8.1. Technical Support

After reading and following the troubleshooting and validation procedures in this document and not being able to resolve an issue, please feel free to contact DG technical support. For users in the United States, technical support is available from 9 a.m. to 5 p.m. Eastern Time. You may also fax or e-mail your questions to us. For prompt assistance, please include your voice telephone number and the serial number located on the back of your DPA.

Users not residing in the United States should contact your local DG representative.

DG Technologies Technical Support

Phone: (248) 888-2000
Fax: (248) 888-9977
E-mail: techsupp@dgtech.com
Web site: www.dgtech.com

8.2. Return Merchandise Authorization (RMA)

If technical support has deemed that there may be a physical problem with your DPA, you will be issued you an RMA number. You would then return the product along with any documentation of ownership you have (proof of purchase/price) to the following address:

Product Service/Repairs
Attn: RMA# xxxxxxx
DG Technologies
33604 West 8 Mile Road
Farmington Hills, MI  48335
9. Warranty Information and Limitation Statements

9.1. Warranty Information

The Dearborn Group, Inc. DPA is warranted against defects in materials and workmanship for two (2) years following date of shipment. Cables (both USB and vehicle) are warranted for 90 days.

Dearborn Group, Inc. will, at its option, repair or replace, at no cost to the customer, products which prove to be defective during the warranty period, provided the defect or failure is not due to misuse, abuse, or alteration of the product. The customer is responsible for shipment of the defective product to DG. This warranty does not cover damage to any item that Dearborn Group, Inc. determines has been damaged by the customer's abuse, misuse, negligence, improper assembly, modification, or operation of the product.

A Return Merchandise Authorization (RMA) number must be issued to the customer by our Technical Support Department at (248) 888-2000 and must be included with the product being returned (for more details, see section Return Merchandise Authorization (RMA)). A DPA is warranted for 90 days after a warranty repair, or to end of the original factory warranty period, whichever is longer.

9.2. Limitation Statements

9.2.1. General Limitation and Risk Assignment

To the maximum extent permitted by applicable law, Dearborn Group, Inc. and its suppliers provide support services on an “as-is” basis and disclaim all other warranties and conditions not specifically stated herein, whether express, implied or statutory, including, but not limited to, any warranties of merchantability or fitness for a particular purpose, lack of viruses, accuracy or completeness of responses, results, lack of negligence or lack of workmanlike effort, and correspondence to description. The user assumes the entire risk arising out of the use or performance of the device, its operating system components, and any support services.

9.2.2. Exclusion of Incidental, Consequential and Certain Other Damages

To the maximum extent permitted by applicable law, in no event shall Dearborn Group, Inc. or its suppliers be liable for any special, incidental, indirect or consequential damages whatsoever, including but not limited to: damages for loss of profit, loss of confidential or other information; business interruption; personal injury; loss of privacy, failure to meet any duty (including good faith or of reasonable care); negligence; and any other pecuniary or other loss related to the use of or the inability to use the device, components or support services or the provision of or failure to provide support services or otherwise in connection with any provision, even if Dearborn Group, Inc. or any supplier has been advised of the possibility of such damages.

9.2.3. Limitation of Liability and Remedies

Notwithstanding any damages that you might incur for any reason whatsoever (including, without limitation, all damages referenced above and all direct or general damages), in no event shall the liability of Dearborn Group, Inc. and any of its suppliers exceed the price paid for the device. The user assumes the entire risk and liability from the use of this device.

9.2.4. Right to Revise or Update without Notice

Dearborn Group, Inc. reserves the right to revise or update its products, software and/or any or all documentation without obligation to notify any individual or entity.

9.2.5. Governance

The user agrees to be governed by the laws of the State of Michigan, USA, and consents to the jurisdiction of the state court of Michigan in all disputes arising out of or relating to the use of this device.

9.2.6. Contact

Please direct all inquiries to:

Dearborn Group, Inc.
33604 West 8 Mile Road
Farmington Hills, MI 48335
Phone (248) 888-2000
Fax (248) 888-9977
Appendix A – Volvo/Mack 2013 (and Newer Vehicles) and the DPA 5

NOTE: This section applies to the 2013 and newer Volvo/Mack chassis with Volvo engines and does not apply to the Volvo/Mack chassis with a Cummins engine.

Beginning in 2013, Volvo introduced a new diagnostic connector for a Volvo/Mack chassis with a Volvo engine. It is based “in part” on the SAE standard J1962 connector (see image below). It will have two separate CAN channels with the ISO15765 protocol on CAN Channel 1 and J1939 on CAN channel 2. It will also have J1708 in the connector as well.

Since there is a second CAN channel and a J1708 channel that are not part of the J1962 OBDII standard, this has required every diagnostic adapter vendor to develop a new cable (or set of cables) for this specific platform. The following diagram shows the pinouts of this connector:

<table>
<thead>
<tr>
<th>Pin</th>
<th>CAN Channel</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>CAN 2 +</td>
<td>J1939 +</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>CAN 1 +</td>
<td>ISO15765 +</td>
</tr>
<tr>
<td>11</td>
<td>CAN 2 -</td>
<td>J1939 -</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>J1708 +</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>J1708 -</td>
</tr>
<tr>
<td>14</td>
<td>CAN 1 -</td>
<td>ISO15765 -</td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>BAT (+12V)</td>
</tr>
</tbody>
</table>

The following sections explain what cables to use.
DG-DPA5-9OBDII-CABLE – For Volvo PTT and Other OBDII Applications

The DG-DPA5-9OBDII-CABLE has an OBDII connector that meets the needs of Volvo PTT on this vehicle platform as well as light-duty, medium-duty, and heavy-duty OBDII vehicles using the following protocols:

- ISO15765 (mandated in all 2008 and newer vehicles)
- J1850 VPW (General Motors/Chrysler)
- ISO9141 and ISO14230 (mainly European vehicles)

This cable works with Volvo PTT, DG Diagnostics (OBDII), Palmer ScanXL, PocketFleet Diagnostics, and RA Consulting Silver Scan Tool. While connected to 2013 and newer Volvo/Mack vehicles, a user cannot connect to a component application like Allison, Eaton, Meritor-WABCO or Bendix through this cable!!!

This cable also has a standard J1939 Type II (250k and 500k) connector. This keeps the user from having to switch cables between an OBDII vehicle and a standard Deutsch 9-pin vehicle using J1939 and/or J1708/J1587.

DG-V13-XOVER-CABLE – For Component Applications (i.e. Allison, Eaton)

The DG-V13-XOVER-CABLE has a special purpose. While connected to 2013 and newer Volvo/Mack vehicles, this special connector cable only works for component applications like Eaton, Allison, Meritor-WABCO, Bendix, etc. A user cannot connect to PTT with this adapter cable in place!!!

This cable is used in conjunction with the DG-DPA5-9OBDII-CABLE.
Using AVT to Test This Vehicle Platform – J1708 Protocol
1. Connect the DG-DPA5-9OBDII-CABLE (only) to the DPA 5 and the vehicle OBDII connector.
2. Run AVT.
3. Select
   i. Vendor: DGDPMA5MA - Dearborn Group DPA 5 Multi Application
   ii. Device: Select the correct DPA
   iii. Protocol: J1708
4. Press the **Run Test** button.
   i. See the section on troubleshooting for test results. Green/green indicates J1708 is working.

Using AVT to Test This Vehicle Platform – ISO15765
1. Connect the DG-DPA5-9OBDII-CABLE (only) to the DPA 5 and the vehicle OBDII connector.
2. Run AVT.
3. Select
   i. Vendor: DGDPMA5MA - Dearborn Group DPA 5 Multi Application
   ii. Device: Select the correct DPA
   iii. Protocol: ISO15765
4. Press the **Run Test** button.
5. See the section on troubleshooting for test results. Green/green indicates ISO15765 is working.

Using AVT to Test This Vehicle Platform – J1939
1. Connect the DG-DPA5-9OBDII-CABLE (only) to the DPA 5 and the vehicle OBDII connector.
2. Run AVT.
3. Press the **Advanced Test** button to get the Advanced Test dialog box.
4. Select
   i. Vendor: DGDPMA5MA - Dearborn Group DPA 5 Multi Application
   ii. Device: Select the correct DPA
   iii. Protocol: J1939
   iv. Baud Rate: 250
      1. Check **Use Baud Rate** checkbox.
   iv. Channel: 2
      1. Check **Use Channel** checkbox.
5. Press the **Run Test** button.
6. See the section on troubleshooting for test results. Green/green indicates J1939 on CAN Channel 2 is working properly.
Appendix B – Sample Source Code for Software Engineers

DG Technologies provides the most complete and comprehensive set of RP1210 and J2534 sample source code for software engineers looking to read data from vehicle and equipment data buses. These files show all software engineering concepts for using either the RP1210 or J2534 API, including:

- Declaring RP1210 and J2534 Function Headers and Function Pointers
- Loading the RP1210 and J2534 Dynamic Link Library (DLL) and Assigning Function Pointers
- (Open) Connecting to a Data Bus Protocol and Setting Filters for Communications
- (Read) Reading Messages, Printing Read Messages, and Decoding Message Data into Engineering Units
- (Write) Sending Messages, Printing Transmitted Messages, and Encoding Data to be Sent
- (Close) Disconnecting from the Data Bus and Freeing the DLL and Resources

These files typically reside in the following directory:
C:\Dearborn Group Products\RP1210 Utilities\SampleSource

### RP1210 Sample Source Code

<table>
<thead>
<tr>
<th>Language/Environment</th>
<th>File Name(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>C/C++</td>
<td>SampleSource.c</td>
</tr>
<tr>
<td>C#</td>
<td>RP1210SampleCodeCSharp.cs</td>
</tr>
<tr>
<td>Python</td>
<td>SampleSource.py</td>
</tr>
<tr>
<td>VB.Net</td>
<td>VBRP1210SampleSource.vb</td>
</tr>
<tr>
<td>Matlab</td>
<td>For a future release.</td>
</tr>
<tr>
<td>Labview</td>
<td>For a future release.</td>
</tr>
</tbody>
</table>

### J2534 Sample Source Code

<table>
<thead>
<tr>
<th>Language/Environment</th>
<th>File Name(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>C/C++</td>
<td>J2534SampleSourceISO15765.cpp</td>
</tr>
<tr>
<td>C#</td>
<td>J2534SampleCodeCSharp.cs</td>
</tr>
<tr>
<td>Python</td>
<td>For a future release.</td>
</tr>
<tr>
<td>VB.Net</td>
<td>VBJ2534SampleSource.vb</td>
</tr>
<tr>
<td>Matlab</td>
<td>DPA5End.m</td>
</tr>
<tr>
<td></td>
<td>DPA5Start.m</td>
</tr>
<tr>
<td></td>
<td>DPA5_PassThruReadMsgs.m</td>
</tr>
<tr>
<td></td>
<td>DPA5_PassThruWriteMsgs.m</td>
</tr>
<tr>
<td></td>
<td>libfunctionsview.pdf</td>
</tr>
<tr>
<td></td>
<td>MatLab_J2534_Syntax.ppt</td>
</tr>
<tr>
<td>LabView</td>
<td>For a future release.</td>
</tr>
</tbody>
</table>
Appendix C – FCC and Certification Industry Canada Information

The DPA 5 has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules (see the back of the DPA 5 for FCC and IC specific identifications). These limits are designed to provide reasonable protection against harmful interference in a residential installation. The DPA 5 uses and generates radio frequency energy. If not installed and used in accordance with the instructions, it may cause harmful interference to radio communications. If the DPA 5 does cause harmful interference to radio or television reception, which can be determined by turning the affected equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving and/or sending antennas.
- Increase the separation between the DPA 5 and the affected receiving equipment.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This product complies with FCC OET Bulletin 65 radiation exposure limits set forth for an uncontrolled environment.

**Industry Canada**

Operation of the DPA 5 is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

Changes not expressly approved by Dearborn Group, Inc. to the DPA 5 could void the user's authority to operate the DPA 5. The following is a sample rear label from the DPA 5 depicting the FCC and IC identifiers.

![Sample Rear Label](image)

The following are the DPA 5 Bluetooth details as required to be published by the FCC:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Frequency</td>
<td>2.4GHz</td>
</tr>
<tr>
<td>Power Output Maximum</td>
<td>&lt; 4.4dBi</td>
</tr>
<tr>
<td>Contains Transmitter Module FCC ID</td>
<td>QOQWT11</td>
</tr>
<tr>
<td>Transmitter Bluetooth QDID</td>
<td>B012647</td>
</tr>
</tbody>
</table>
Appendix D – List of Acronyms Used in this Document

Various acronyms have been used throughout this document.

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>AVT</td>
<td>Adapter Validation Tool</td>
</tr>
<tr>
<td>CAN</td>
<td>Controller Area Network</td>
</tr>
<tr>
<td>CD</td>
<td>Compact Disk</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Compact Disk - Read Only Memory</td>
</tr>
<tr>
<td>DG</td>
<td>Dearborn Group</td>
</tr>
<tr>
<td>DPA</td>
<td>Dearborn Protocol Adapter</td>
</tr>
<tr>
<td>DTC</td>
<td>Diagnostic Trouble Codes</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>ISO</td>
<td>International Standards Organization</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>OBD</td>
<td>On Board Diagnostics</td>
</tr>
<tr>
<td>OEM</td>
<td>Original Equipment Manufacturer</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RP</td>
<td>Recommended Practice (see TMC)</td>
</tr>
<tr>
<td>SAE</td>
<td>Society of Automotive Engineers</td>
</tr>
<tr>
<td>TMC</td>
<td>Technology and Maintenance Council</td>
</tr>
<tr>
<td>UAC</td>
<td>User Account Control</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VDA</td>
<td>Vehicle Datalink Adapter</td>
</tr>
</tbody>
</table>